[bookmark: _j07uilsl0trm]   Renderman for Maya Reference written by Ryan Wiley 2018
[bookmark: _dtybfbdswrz2]Creating a Renderman Scene in Maya
[bookmark: _wwsef97jvpfs]Modeling with and without Creases
[bookmark: _2nqz4xa679qy]Building Materials
[bookmark: _x6jncek4ca3p]Textures, .TEX files, and TXMAKE
[bookmark: _vd2koxnyx2t2]PxrSurface
[bookmark: _ly2yahodrdui]Diffuse
[bookmark: _ly2yahodrdui1]Primary Specular
[bookmark: _ly2yahodrdui2]Auxiliary Speculars
[bookmark: _fymdbltt6sy4]Subsurface Scattering
[bookmark: _qp7viicx83m0]Single Scatter
[bookmark: _cgo4ge30vgte]Iridescence
[bookmark: _i6h9qwcj0byj]Fuzz
[bookmark: _ly2yahodrdui3]Glass
[bookmark: _ly2yahodrdui4]Glow
[bookmark: _88ffso81c3sp]Globals
[bookmark: _rbkhi5tu7420]PxrLayerSurface
[bookmark: _vdke0dp060y1]PxrConstant
[bookmark: _dy4ubtb20hqf]PxrBlack
[bookmark: _sozhqlrvq19f]Patterns/Utilities
[bookmark: _7szwr1mh26ua]Maya Viewport
[bookmark: _v8iphwl8fkhk]Modifying a Scene for Render
Before rendering, the following stages of production need to be finalized:
· Modeling, UVing, Texturing
· Rigging
· Environment Placement and Organization
· Camera Animation
· Character and Scene Animation
· Lighting
· Effects
Download the entire production folder to your desktop.
Once the preceding stages are ready, you still need to prepare the scene file itself for rendering. You are going to be making a number of “destructive” changes (non-reversible) to the scene file on a per-shot basis; When you are prepared to move forward, you should start saving to a new file that is dedicated to each shot and exclusively for rendering purposes. 
[bookmark: _njra7wis3zdi]Preparing the Environment
The scene is going to have a lot of objects and geometry that are not directly necessary for rendering, especially things that are behind or outside the view frustum of the camera. These things may still be visible in the reflections of materials that are within the view of the camera, so you will have to make some judgement calls on what to keep and what to hide.
If an object is outside the camera-view, but will be visible to reflections, and will have visible animations, you may need to leave that object in scene or discuss with the responsible authorities (directors, art directors, etc.) about its importance. Any geometry that will be static and out of view can be replaced with an environment map. You may also want to keep any objects that cast a significant shadow into view, though these objects can also be replaced with a Gobo Light Filter using a texture to simulate the now hidden object.
[bookmark: _u4612tydy30f]Rendering an Environment Map
Much of the time, environment maps are used to simulate real world lighting conditions but they can also be used to more simply simulate reflections. You are going to use it for the later.
Go through your environment and temporarily hide the previously mentioned animated objects that will be kept for the final render.
You’re now going to set up a few cameras that will capture a partial environment map depicting the area outside the shot’s camera view. For a full environment map you would need six cameras pointing in the +x, -x, +y, -y, +z, and -z axis, but since you only need to capture the portions of the environment outside the shot camera’s view frustum you will only need three or four.
Create a new camera and give it a name like “shot#EnvCamLeft”, or something more appropriate for your production. For now, leave the camera at the world origin. You are going to change a number of the default settings to account for the cube style projections you will need for the environment map (shown next page).
	· Change the Camera Aperture (inch) to 1.000 x 1.000
· Change the Angle of View to 90.00
· The Focal length should now automatically change to 12.700
· You may want to activate Display Frustum to check that the edges of your cameras are aligning
· Activate Renderable under the Output Settings
· Go to the Transform node for the camera and change the y rotation to -90 (i.e. the left direction)
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	Your first camera is now ready. Duplicate it twice, changing the names to replace “Left”, with “Right” and “Back” on the duplicated cameras (the shot camera is essentially taking the place of the “Front” camera of a full environment map setup). Change the Right camera’s y rotation to 90 and the Back to 0. Group your cameras together and name it appropriately.
You now have to make a choice about the origin of where you are going to render the environment map. If the shot camera moves during the shot, you may want place the environment cameras in the middle of that camera movement. You can also render out the environment map to test the view and refine the placement afterwards.
For now, move the camera group to where you want it. Rotate the group on the y axis so that the three view frustums are outside that of the shot cameras.
	[image: ]

	
	The environment map cameras are highlighted. See how the view frustum for the shot camera does not crossover the other cameras.




[image: ]Go to your render settings and rename your File name prefix to something like “shot#_envMap”.Change the Frame/Animation ext to name.ext (Single Frame). Change the image size preset to 1k Square. Delete the shot camera from the renderable cameras list and make sure all of your environment cameras are listed. Depending on the screen size of the reflecting materials in your shot, you will find that you will not need as large of an image size for your environment map. On a shot where a reflecting material surface is very close to the shot camera and shows a lot of the occluded environment, you may have to go larger with this setting.
Make sure you are using the RenderMan renderer. Go to the Sampling tab. The Max Samples setting here will be proportional to how large you made the image size. If you stuck with 1k, then 64 samples will probably be fine. Go to the Passes tab and make sure that only the default rgba Output is listed (shown right).
For the Image Format, OpenExr will probably be best because of its high bit depth. Close the Render Settings dialog.
Go to the Renderman Menu and click Batch Render. Maya will prepare the scene for render and send the appropriate files to Local Queue. Once Local Queue opens, it will start rendering the three cameras sequentially in the background using Renderman. Inside Local Queue you can see where its sending the final images. The images will usually be located inside the project folder and then under these folders (the numbers you see are a timestamp for when the render was initiated):
[bookmark: _b36nyr2ttqj6]renderman\shot61_EnvCamera_Test_0110133734\images
Each of the three cameras has there own folder, with the single frame images inside each folder. Copy these images to the Sourceimages project folder of your project, renaming them to indicate which folder they are from (i.e. “shot#_envMapLeft.exr”).
Now it is time to test them out in the scene. Use TXMAKE to convert the .EXR files to the more renderman friendly .TEX files. Create a Cube object. Delete the front, top, and bottom faces. Select the right side face and apply a pxrConstant material to it, renaming it to something like “pxrShot#EnvRight”. Connect a maya file node to the Emit Color channel. Navigate to the appropriate .TEX file and select it. Repeat this process for the left and back faces with new pxrConstant materials.
Go to the Mesh Display menu and click Reverse. Open the UV Editor dialog. You are going to have to change the UV mapping for the faces so that each face takes up the entire UV quadrant. You will likely also have to flip the faces so that the textures correctly line up with each other.
You can now move the Environment Map to the specific location and rotation of the camera group. It will not perfectly line up with the actual background environment but that is ok as it is only meant to approximate it for reflections.

[image: ]You also want to prevent the Environment Map from accidently showing up in the camera view during render, or to cast shadows in the shot. To prevent this, go to the shape node for you Environment Map in the Attribute Editor. Go to Attributes Menu > Renderman > Visibility Settings at the top (shown right).
[image: ]At the bottom, below the Extra Attributes dropdown, a new Renderman dropdown should be visible. Open it up and see three new Attributes (shown below).
Camera Visibility controls just what it sounds like, the objects direct visibility to the camera. Indirect Visibility controls an object’s visibility in indirect lighting, i.e. reflections and bounce lighting. Transmission Visibility controls an object’s visibility to shadows, i.e. the object will or will not cast shadows/block light.
For the environment map, turn off Camera and Transmission Visibility, so that it will only show up in reflections and indirect lighting.
[bookmark: _k1k5u1ulapyw]Emissive Materials and Light Groups
Of note, when rendering using Light Groups, any materials that emit light (i.e. glow on pxrSurface, or pxrConstant materials) will influence every Light Group; Since emissive materials are not technically lights, they do not respect Light Groups and their method of occluding. To isolate the lighting from an emissive material, you can render it separately, and turn off all other lights; then, when rendering the actual lights in the scene, turn off all emissive materials so they do not unduly influence your regular lights
[bookmark: _bb18vcrk0083]Spherical Environment Maps (easier)
A much easier way to get an Environment Map is to use a spherical camera, and luckily, Renderman has a setting for that. Create a new camera and go to the Film Back drop down in the attribute editor. Change the Camera Aperature (inch) to 1.0 x 1.0. Add the Renderman attributes of Type, Horizontal Sweep, and Vertical Sweep to the camera. Change the Type to sphere, Horizontal to 360, and Vertical to 180. Go to the Render Settings and set the the Image Size to 1024 to 1024 (depending on what you are going to use this Environment Map for, you may be able to higher or lower).
[image: ]
[image: ]
You should now be able to render out a sphere map. Convert the image to .TEX, save it in the texture/job folder, apply it as the Emit Color on a PxrConstant material on a new sphere. From the Mesh Display menu click reverse (the normals are set to face outwards by default). Go into the UV editor and flip the UVs along the U axis (you just reversed the normals, so you have to flip the UVs to compensate for mirrored image). You may also have to rotate the sphere on its Y-axis depending on where the camera was facing when you rendered the Sphere Map. 
The same as the Cube Map, make sure to turn off Camera Visibility and Transmission Visibility.
[bookmark: _2s51h664dhi3]Hiding Geometry
Now go through the environment and hide the objects that you determined earlier were unnecessary. You can also go through and selectively delete the portions of the ground plane that lie outside the shot camera view. It may be best to go into the reference editor and unload the specific references to objects you do not need for rendering.
[bookmark: _dtyqw77g19h7][image: ]Importing all References/Exporting Selection
You do not want Maya having to constantly deal with loading references every time you are going to be making edits to your files. Once final changes to the shot are done, you can start importing all your references using the Reference Editor. Depending on how complicated your scene is, you may want to import only portions of it a time. By the end, your Reference Editor should be empty.

If anything gets updated after you have started using a fully imported combined file, you can reimport the new version and delete the outdated object. If it is just an update to textures, you can replace the .TEX files inside the Renderman/Textures/Job project subfolder, and Renderman will use the new textures automatically the next time you render.
A second way to create a new combined version of your shot file is to set your viewport to your current shot, making sure that the viewport is set to view All. Scrub from the first frame of the shot to the last and select everything that comes into view. Go through the outliner and select anything the scene will need access to that isn’t in view of the camera (i.e. the nodes associated with particles, the shot camera itself, lights that affect the shot). Once you’re satisfied you’ve selected everything you’ll need to render, click Export Selected from the File menu. Inside the File you will see the options shown to the left; set them up as shown and save your new shot file.
Once your new file is exported, open it in Maya and inspect it to make sure you’re not missing anything, and if you are, go back to the previous file, select the missing items, re-export them to a new file, and import that file to your combined shot file. You may have to do some render tests with someone from lighting to double check everything is there.
[bookmark: _sdhq5jdx6ddk]Light Linking
Most likely your lighting team will be adding many lights to each shot, with some lights being specific for certain objects (i.e. a key light for a character). The Art Directors and Lighting Leads may not want some lights affecting the entire scene, so will use Light Linking to manage connections between lights and objects. A problem that seems to occur with Light Linking and References/Importing/Transfering files is that the linking will break sometimes.
After creating your combined shot file, you may want to sit down with the lighting artist/s who worked on that particular shot and verify that each light is still set up properly. The Light Linking Relationship Editor helps to more easily manage these. For our project we had our Lighting Team build a Light Linking document just in case we couldn’t sit down with them to fix any issues.
[bookmark: _1xp5r5dkay3m]Light Groups
If you want to composite the lights in your shot separately, you are going to have to organize your light into light groups which will then have their own AOVs.
An easy way to navigate the Renderman lights in your scene is to use the Renderman Light Lister. You can find it from either the Renderman Shelf or Menu. Once you have opened it you will see three lists, the first appearing like the outliner but with only the Renderman lights in the scene listed.
[image: ]
Select one of the lights you will be using for your shot. Go over to the Attribute Editor and navigate to Attributes > Advanced drop down. You will see the Light Group text box. Give the light an appropriate name (i.e. “envLG” for Environment Light Group). The names should be relatively short as they will be used in the names for your AOVs later and can make it harder to navigate.You can collect multiple lights into one light group but you will not be able to do compositing corrections to the individual lights later. Go through all the lights you will need and put them in Light Groups.
[image: ]
[bookmark: _u3tok63qrf7g][bookmark: _u3tok63qrf7g]
[bookmark: erbq9vdywxoz][bookmark: _dtlgcgyzhmbk][bookmark: erbq9vdywxoz][bookmark: _dtlgcgyzhmbk]

[bookmark: _qlmtz4rg69tg]Geometric Settings
The standard way in Maya of separating out the characters from the environment for later compositing, is to use Maya Render Layers. These allow you to control attributes on Collections of objects (in this case, Primary Visibility) all at once without having to edit each individual object. The problem with this method and using Renderman, is that any AOVs you use will apply to every Render Layer. Some AOVs should be disabled for certain portions of a shot to save on space and render time.
Another way to manage this is use separate render files for your characters and environment (you may even want to render parts of the environment separately if they have different rendering settings than the majority of the environment). With each distinct render file you can then manage render settings as needed.
[bookmark: y6anjjwb9gzn][image: ]While the Maya Primary Visibility setting works with Renderman, it gives you only limited control of the Visibility of objects within Renderman. Renderman has its own unique Visibility settings hidden from initial editing. There are two primary ways to access these settings, either through the individual object or through the Geometric Settings Editor. Since you are going to want to modify these settings across multiple objects at once, the Geometric Settings Editor is the better choice.
Go to the Renderman Menu > Advanced Renderman Controls…(shown right).
[image: ]You will spending a good bit of time in this dialog while preparing for rendering. For now, go to the View Menu >            ⭘ Geometric Settings (shown below).
For the purposes of this tutorial, you are going to see the Geometric Settings applied to the Abueluna character, but can be applied to any character or object. Click the Create button to start a new Geometric Settings group. To rename this group you may have to click multiple times on it before it allows editing. Name it something appropriate for your character (i.e. “abuelunaVisbility”).
To add things to these groups correctly, you must first select the bottom most shape node for that object. Anything that is rigged or has a deformer will have a “...ShapeDeformed” node replacing the primary shape node. To make sure you are selecting the proper node, open the Outliner, and go to the Display Menu > ⬜ Shapes, this will reveal the shape nodes inside the outliner. To expand the entire node tree for a group, shift + left-click the ⊞ symbol next to the top node. Go through your character node tree and select every bottom most shape node and then click the Attach button in the Geometric Settings back in the Renderman Advanced Settings dialog. 
NOTE: objects are not listed anywhere in the window. The only way to ensure objects are attached to the Geometric Setting Group is to deselect everything in the viewport, selecting the Geometric Setting Group listed in the Renderman Controls window, and then clicking the “Select” button. Make sure everything you intended to belong in the group is now highlighted in the viewport.
Open the Add/Remove Settings drop down menu at the bottom of the Geometric Settings. Right-click the Camera Visibility attribute in the Optional Attributes list, then inside the pop-up menu click Add Selected.

[image: ]Inside the Settings tab you will see the newly added Camera Visibility. If you deactivate it for now and do a test render, you will see that your character is no longer visible, but they still cast a shadow onto the environment.
[image: ][image: ]
Viewport vs. Renderman

You are now going to go through and make a separate Geometric Settings group for each character, the environment, and anything inside the environment you want to composite into the final shot separately. Add the Camera Visibility setting to each group.
You will also want to make a seperate Geometric Settings group for Subdivision smoothing. Create the group, select every object that needs to be smoothed. Click the Select > Hierarchy menu, which will select every node under your current selection and attach them to the new group. Add a Subdivision Scheme attribute to the group. This group will now smooth every object attached to it at render time.
[bookmark: _f59g46enn43w]Caching Effects
Any dynamic effects in the shot need to be cached so that they stay consistent throughout the different phases of rendering, including any rerendering that may need to be accomplished later. For geometry deformations you can use Geometry Caching, for Particles or Water you can use nCache. Just make sure that if you transfer your project folder to another location for local rendering you must also include the Cache folder.
If someone else has created caches for your shot, you need to make sure it is loaded into the scene (Geo, nParticle, Alembic Cache).
[bookmark: _qk0nahay1aw6]Double Check Student Version
Before you save out to a .MB (Maya Binary) version of the scene file, you may want to double check and make sure the .MA (Maya ASCII) version was not saved with the Student Version tag. Open your scene file in a basic text editor and look for something similar to the following line:
[bookmark: _eai8h5vbhj39]fileInfo "license" "student";
Delete this line and save the file.
[bookmark: _5803o99pwf7m]Watertight Dicing (gaps in geometry)
If you see gaps showing up between faces on geometry, activate Watertight Dicing under the Advanced tab in your Renders Settings. We will be using this on every one of our shots, as sometimes you won’t notice the gaps until after rendering.
[bookmark: _bwpxhn5y3sqr]Save as Maya Binary
You can now save your scene file to the .MB format. If you end up reimporting files with fixes that give you the Student Version pop up again, you can resave as .MA, edit the file, and save as .MB again.
[bookmark: _y6myimcguzzr]Instancing and Subdivision Smoothing
In some instances you may have a scene with many instances of the same object. Renderman uses these objects to render quicker by using attributes from the original object on every instance. With Subdivision Smoothing, this seems to create weird artifacts around the edges of blocky geometry. Go to the Renderman Controls in your Geometric Settings. If you add the Instance Dicing Method to the original asset and set it to spherical and add Dicing Length and set it to about 5.0, this will allow any instance made from that asset to render correctly.
[bookmark: _pdzm8xa3omcz]Smoothing and Mesh Lights
This may be an issue for specific versions of Renderman, but if you have a mesh that uses both a Mesh Light and some other material and needs to use smoothing, your render may fail. For situations like this, use Maya to apply smoothing directly to the mesh and don’t let Renderman smooth it (i.e. don’t use viewport smooth preview or add the subdivision scheme attribute to the object).
[bookmark: _3tashxc75vnp]Adding AOVs
[image: ]AOV stands for Arbitrary Output Variable and is the name Renderman and a few other renderers use to describe Render Passes. There are quite a few AOVs available in Renderman, including the ability to create custom ones built using shaders or Light Path Expressions (LPEs). There are two other terms you may see; Channels and Outputs. Channels are the individual types of light or data rays that can be captured for export or display. Outputs are what Renderman uses to actually save the Channels to a file, including filter information. Outputs can export multiple Channels to a single file using OpenEXR (.EXR) or .TIF.
[bookmark: _9ey4fpp5r9wf]Simple AOV Setup
If you were going to create a simplified AOV setup you can add them directly from the Render Settings window. Inside Render Settings under the Passes tab, by default, you will see an output called “rgba,” which is simply the beauty pass that has all Channels combined. Look for the Output text box. Next to the text box is a ⛭symbol, click on it. Click the menu Create Output > Custom…
[image: ]This new dialog can be used to create custom Outputs and Channels. For now right click the Output Channels textbox to see the available Channels and then click on Direct Diffuse. It will be added to the textbox. You can continue this process to add multiple Channels to this single Output. For now, add Indirect Diffuse, name the Output “diffuseAOV,” and click the Create button. You now have an Output that has all the Diffuse information and should render to a single openEXR file (the default for Renderman).
[bookmark: 908dvu6zcfzd]To recreate the Beauty render as you see it when you do preview renders, you can use a number of different composite schemes. Some of these depend on what types of materials you are using in the scene, if you are only using Diffuse without directly visible lights, you would only need a single Diffuse channel and it would look the same as the Beauty render. Unless your production is using a very simplified and stylized look, you will probably need more than Diffuse alone. Add Specular if you are using reflections, Transmissive for glass, Subsurface for subsurface scattering, or Emissive for glow/visible lights/pxrConstant (you will not need an Emissive pass for each Light Group, as lighting does not affect this Channel).
[image: ]Direct Diffuse + Direct Specular + Indirect Diffuse + Indirect Specular + Transmissive + Emissive + Subsurface is the simplest composite scheme, without using custom LPEs, that will capture every type of material and lighting scenario. Diffuse, Specular, and Transmissive can all be broken down into their more specific Lobes. Lobes are some of the most granular types of Channels and you will most likely not need them.
There is also a Shadow Channel that can be used with the Unoccluded versions of the Diffuse and Specular Channels to allow for greater compositing control. A problem in using the Shadow Channel in this way is that it will come out lighter than the beauty pass version. Another way to get a Shadow pass is to divide an Occluded Channel by its Unoccluded version during compositing, make changes to the shadows as needed, and then multiply them back onto the Unoccluded Channel.
To see a more in depth description of Channels and LPEs, you can go to the Renderman Docs.
This is about as far as you can get while staying inside the Render Settings dialog to build your Outputs and Channels.
For our project we used:
· Albedo (only need one per shot NOT per light group)
· Direct Diffuse
· Direct Specular
· Emissive (only need one per shot NOT per light group)
· Indirect Diffuse Unoccluded
· Indirect Specular Unoccluded
· Transmissive (only if the shot has glass materials)
[bookmark: _64flciqew5q7]Complex AOV Setup
You are going back to the Advanced Renderman Settings dialog. Under Default Settings you will see Bake, Final, and IPR; Click Final then under the Outputs tab you will see your Outputs and Channels. If you open the Add Channels/Outputs drop down near the bottom you will reveal six tabs categorizing the different Channels you can use.
Once you start using Light Groups, you will be using the Channels under that tab to start populating the list. For now, click the LPE tab and ctrl+click the Channels described earlier (Direct Diffuse, Direct Specular, etc.). Right click one of the highlighted channels and select Create One Output from Channels. The upper list will now have an All Channels group (it has every channel you have added), the default beauty Channel/Output, and a new Output group with its corresponding channels under it. Channels can be shared between groups and they can be drag-and-dropped in and out of Outputs. You can double-click some outputs and rename them to something shorter or easier to read. It is up to you how the Channels and subsequent Outputs are organized, but if someone else has to do the compositing on your rendered shot, it may be helpful to name things with an eye for readability.
A note; The Advanced Renderman Settings dialog can be finicky. If you are seeing erratic behavior, it may help to close and reopen the dialog to reset it.
Another problem; when batch rendering, Maya may fail to render; if this happens, you may have to separate each Channel into its own Output (thus separate .EXR files). Having multiple files representing each channel can quickly become unwieldy, but it may be the only way to get your final render done.
If you want to composite each Light Group separately you will have to add the necessary channels for each Light Group. If you are using separate render files for each character and the environment, you will only need to use the light groups that will affect that particular render file (i.e. you do not have to add a character’s key Light Group Channels to the environment render file).
[bookmark: _o39plbhe45ti]Data Passes
Both Motion Blur and Depth of Field can be automatically calculate into the LPE based passes, or can be setup as their own Data Passes which can then be used in compositing for later tweaking. With Motion Blur, there are a few Passes that can help achieve this effect, but the motionFore pass seems to be the easiest and better looking method to use. For zDepth, either z or depth can be used.Full Light
Loss of Light

[bookmark: _qrzm3qj2zne]Motion Blur, motionFore
For motion blur to be calculated during compositing instead of rendering, some settings need to be changed in addition to adding the appropriate AOV pass.
[image: ]Go to the Render Settings dialog and open the Features tab. Turn on Motion Blur and Camera Blur (if you want camera movement to also be calculated as part of the motion blur. Go to the Passes tab and then the Pass Settings sub-tab. Under the Extra Settings drop down menu click the Add/Remove Settings button. In the new dialog box scroll down to and select the Sample Motion setting, and click the Add button. Close this dialog and go back to the Render Settings dialog. The Sample Motion setting is now available for editing under Extra Settings. Deactivate Sample Motion, this will allow Renderman to calculate Motion Blur without actually applying it to the Passes except for the data Passes.
[bookmark: _1yrzifoepdsw]zDepth, float z
If your shot is going to use Depth of Focus, you can have Renderman add this effect directly to your Passes or the associated Data Passes instead. The float z Pass will only give depth information, in the red channel specifically, while the color depth Pass uses depth/height/facing ratio, in the red/green/channels respectively. Unless you plan on using the height and facing ration information for something while compositing, it is suggested to float z Pass instead.
Just as for motionFore, under the Standard tab, add the Channel and create an Output using float z. When you eventually use this Pass for compositing, the values used for depth are calculated using the Maya-unit distance between the camera and sample surface at that particular pixel. You will have to Grade this pass to actually be used in a Depth of Field effect.
[bookmark: _qn9weh3ni6bo]Alpha, float a
If you want an easier way to composite your characters onto the environment, you can add float a from the Stardard AOV tab. This will give you an rgb based alpha channel you can use a mask for your entire character.
[bookmark: _a9ikltvj4c11]Ambient Occlusion
Ambient Occlusion (AO) has been used in the past to fake the effect of light falling off as geometries would increasingly angle inwards to face each other. With full Global Illumination and the newer Physically Based Renderers (which Renderman uses), AO would not be necessary as more realistic lighting would shade these regions automatically. If your production wants to continue to use AO as a stylistic choice, than a few things need to be done.
AO can not be rendered like other visual Passes or at the same time, as it uses a completely different method for calculating itself. Go to the Render Settings dialog and open the Samping Tab. Scroll down and open the Integrator drop down. Switch from the default Path Tracer Integrator to Occlusion. If when you do a test render of your shot and you feel the AO is too strong or does not seem correct of the scale of your scene, you can come back to these settings and refine them to fit with your project, but for now then can be left at default.
Since you changed the Integrator (the method that interprets the scene to then be sent to the renderer), none of the LPE based Passes will render as intended, so this pass can only be rendered at the same time as Data based Passes. Simply keep the beauty Pass and it will be rendered as AO.
Since AO simulates indirect lighting, you can more use it to replace the shadows used in those passes. When you select your indirectDiffuse and indirectSpecular passes, use the Unoccluded (un-shadowed) versions, which will multiplied by the AO in compositing.
[bookmark: _x03gmf6mm8hi]Full Data Passes
· Beauty (with the Occlusion Integrator)
· Vector motionFore
· Float Z
· Float A

· _Pworld
· _Nworld
[bookmark: _le6eylob8369]MatteID AOV
When attempting to do visual corrections on different elements of your shot during the compositing phase of production, you are going to want an easy method of generating Masks for those elements. For example, if you wanted to do a color correction on a book sitting on a table, you would either have to have completely separate passes for those two elements, manually rotoscope the book from the table, or use Renderman MatteIDs (fyi, these are the better option). One scenario where you would not want to use MatteIDs is if the different elements you want to separate use different render Passes, as discussed earlier.
[bookmark: _umwoegyg5u4h]Manual Setup
[image: ]To manually build you MatteIDs, first go to the Hypershader. Map out the material assigned to the object you wish to attach a MatteID. Now add a pxrMatteID node from the Renderman Patterns category. Connect the Result AOV output from the pxrMatteID to the Utility Pattern[0] of the PxrSurface material node. You may have to access the Other… connections of the pxrMatteID node.That is it for the material.


[image: ]Similar to adding the Visibility settings to the environment map, you will need to add a Renderman Attribute that will control the MatteID color. Go to the Attribute Editor for the object. Go to the Attributes Menu > Renderman > Manage Attributes… Scroll down in the Option Attributes list, select Matte ID 0, click the Add button, and then the Close button. Matte ID 0 has been added to the Renderman drop down of the objects Attribute Editor. Click the color box and set it to full red. You can also add this Attribute to the material itself, thus applying the Matte to every object using that material.
[image: ]Go to the Advanced Renderman Controls dialog and go to the Add Channels/Outputs dropdown. Open the Matte tab, right click the color MatteID0 channel, and click the Create Output from Channel. Do a test render and you should see the object is a solid red with proper anti-aliasing around the edges.
[image: ]
Now comes the tedious part, you are going to have to go through and apply these same steps to every object or material that you want a Matte for. You want to use only red, green, and blue for the colors as it allows you to automatically pipe those colors in as Masks inside a compositing software. Since there are eight unique Mattes with three color channels per Matte, that is only 24 unique Mattes. You can extend your use of each color/Matte by applying the same combination to objects that never visually overlap each other during your shot or groups of similar objects; you can then create a much more simplified rotoscope in composite to break away the separate objects’ masks. If you still need more Mattes than 24 for your shot, you can always copy your shot file and build new Mattes for the remaining objects, thus requiring another render.
[bookmark: _3h05kpyom0j1]Automatic Setup, scripting Addon
It can take a long time to setup Mattes for a complex shot, and can lead to forgetting steps in the process and you may having no idea what is wrong. Luckily, a beautiful soul from Russia has created a script (UltiMatte Mask Picker) that can help speed this up. The script on that page does not currently work for Renderman version 21, but if you go to the comments, an updated script is linked. Once you have the appropriate script downloaded, go to your Shelf Editor (either from the Windows menu > Settings/Preferences > Shelf Editor, or click the ⛭ next to your Shelves and then Shelf Editor...).
Select which Shelf you want to add UltiMatte Mask Picker to, then click the [image: ] under the Shelf Contents section. Add an Icon Label to easily identify the script, then open the Command tab at the top. Select Python as the language and paste the entirety of the script into the text box. Close the Shelf Editor. You now have access to the UltiMatte Mask Picker
Add all the MatteID passes to the Channel/Outputs list like you did for the manual setup and then click your new script button. A dialog opens up and lists the eight MatteIDs, along with a color chooser and Select/Attach/Detach buttons. Select your first object, click MatteID0, choose full red, and click Attach. That is it, your object is now setup with a Matte and a color. If you do not remember if you have already used a MatteID/color combination, then simply select it and click the Select button, it will highlight each object using those settings in your scene. If you need to remove an object from a MatteID, select the object and the MatteID and click the Detach button.
When using UltiMatte, be aware that it will only connect the MatteID node to the first material it encounters on an object. For objects with multiple materials assigned to it (i.e. different faces with different materials) you need to still manually connect the node.
[bookmark: _tu79uvg8wzk0]Refractive and Reflective Mattes (AOV Light)
Normally, MatteIDs cannot be generated for objects that are being occluded by a refractive material. To account for this, you can use a different method for generating said Mattes. In a scene where you have an object being occluded by a refractive material, add a PxrAOVLight from the Renderman menu. This new light is not really a light, but a utility that takes advantage of Maya’s light linking capabilities.
From the menu, Windows > Relationship Editors > Light Linking > Light-Centric
[image: ]
In this dialog click your PxrAovLight you wish to link, and deselect every object except the one you want to create a Matte for. Also make sure you keep the material for the object selected (the AOV will not render without both the object and material selected in this dialog). 
[image: ]
Go to the Attribute Editor for you PxrAovLight. Put something readable for the AOV Name, as this is the actual name for AOV you will add later. For our purposes, turn on Refraction and Reflection. 
[image: ]
Open up the Render Settings. Go to the Passes tab and click the ⊞ symbol next to the Outputs List. In the Create Renderman Output Options dialog type into the Output Channels textbox; “color “ + the AOV Name you typed in above and click the Create button.
[image: ]
If you render now, you should have an output giving you a white and black Matte that properly reacts to refraction and reflection. This type of Matte will allow you to composite objects that show up behind transmissive materials
[bookmark: _rw2iyv35mnm9]MatteID’s and RIB Archives
If you are rendering a scene that uses RIB archives, then the MatteID’s have to be baked into the Archive file. You can use new Archives per shot (which can take up more hard drive space that you want, or you can reserve a color in a matte for that particular Archive and use the same Archive for every shot).
[bookmark: _6nzejws1246r]Denoising
There is an entire process by which Renderman can calculate denoising for your shot, even on individual passes. For now, this needs more research on my part since not all passes need denoising. If you turn on Denoising in the Render Settings and separate each Channel into an Output. When you batch render from command line, the renderer will denoise every pass after rendering the initial frame. This can take a while and will sometimes fail.
[bookmark: _kzjll94lxks4]Render Settings
[bookmark: _k2yprlagmjei]Common Tab
We used the default render settings with some mild tweaking. Under the Common Tab, Color Management dropdown, activate the Apply Output Transform to Renderer setting. Under the File Output dropdown, change the Frame/Animation ext. setting to “name.#.ext”. Make sure the Frame padding is enough to account for the max amount of frames your using (we used 4). Under the Frame Range dropdown, change the Start frame and End frame to the correct frames for your shot (it doesn’t use the time slider settings). Under the Renderable Cameras dropdown, switch to the camera for your shot, and delete any extraneous cameras that maybe present here. Under the Image Size dropdown, set the resolution to what your production is using (we used the HD 1080 preset for ours). Under the Render Options dropdown, deactivate the Enable Default Light setting.
[bookmark: _31m17jcnops5]Sampling Tab
Under the Sampling Tab, you can set a number of settings that account for the general quality of your final render. If you Min Samples are at 0, Renderman will by default use the square root of your Max Samples setting (for our production, we used 8 and 128). Under the Default Ray Depths dropdown, for the Max Diffuse and Specular Ray Depths we used 1, for both. On our glass objects, we added overrides to set them back to 4 each. You can add another Geometric Setting Group and add these two settings, then attach all the glass objects in the scene to this unique group.
[bookmark: _yqu1kag89pw9]Features and Passes Tab
Under the Features Tab, under the Motion Blur dropdown, turn on both Motion Blur and Camera Blur. Under the Passes tab then the Pass Settings subtab, click the Add/Remove Settings, add the Sample Motion setting, and turn it off. This allows for motion blur to be saved out in the data passes without baking it into the color passes.
[bookmark: _m1r8kblw9i5x]Advanced Tab
Under the Advanced Tab, under the Dice dropdown, activate the Dice Watertight setting. This fixes a number of problems where Subdivision smoothed objects will have gaps showing in between faces during render.
[bookmark: _m34gawdge9kd]Legacy Render Layers
With Maya 2017, only Legacy render layers are supported in Maya without batch render errors. To start, you’re going to change your settings to use the Legacy version. Go to the Windows > Settings/Preferences > Preferences menu.
[image: ]
Go to the Settings > Rendering section and change the Preferred Render Setup System to Legacy Render Layers.

Under the Channel Box / Layer Editor side panel, you should see a new Render tab at the bottom. Here is where you will create your render layers.
[image: ]
In the above example, I have a layer for; Ambient Occlusion, Data, MM (a character), Environment Fix (extra passes I forgot to setup during the first render), Environment, and the original MasterLayer. If you have multiple characters, you will need to create layers for each character, so they can be composited separately. To create your first layer, select all objects in your scene (the easiest way would be to select everything in the outliner) and hit this button [image: ]. This will create a new layer with all the selected objects. You don’t have to select any lights or cameras as they are accessible by all layers.
Duplicate this first layer however many times you need. Usually you will have; 1 for the environment, 1 per character, 1 for the data output, and 1 for the Ambient Occlusion (which can be combined with the data layer); for a minimum of 3 with a character.
For this first layer, let’s make it the Environment layer. It’s up to you how you want to name it, but a suggestion towards allowing other people to understand it. With the env layer selected, open the Geometric Settings dialog. Select the character Geometric Settings group and right-click on Camera Visibility and select Create Layer Override. Uncheck Camera Visibility. This is how you will create Overrides for every layer. You can create Overrides for most any attribute in Maya, including entire Shader Groups.
[image: ]
[image: ]
If you have more than one character in your shot, you will need to Override the visibility of each character.
Go to the Render Settings dialog. With the masterLayer selected, make sure all but the default rgba Outputs are set to Compute.

Go back to the env layer and override the Compute settings for the Outputs you won’t need (for this example, I turned off the mmAOV and dataAOV outputs, while leaving envAOV and sharedAOV on). My sharedAOV output has Light Group channels the are needed for both my characters and my environment.
Switch over to the Data layer and create overrides for all the environment and character outputs, hiding them. Switch to the Ambient Occlusion layer and create overrides for every output, hiding the AOV outputs and revealing the default rgba output. Go to the Render Settings dialog, under the Sampling tab, under the Integrator dropdown, create an override for the Integrator and switch it to Occlusion. If you don’t see the Integrator setting, save your file, close and reopen Maya, and do this step over again.
You should be ready to render your file at this point.
[bookmark: _pzwk55l3ska8]Example Final File Setup
Following is an example shot with different layers setup for final rendering (it is simplified for demonstration purposes):
· [bookmark: _x8wm6ori8t2p]Env Render Layer (environment with the character’s Camera Visibility turned off)
· [bookmark: _dto2x6xxdtk0]directDiffuse Ambient Light Group
· [bookmark: _dto2x6xxdtk01]directSpecular Ambient Light Group
· [bookmark: _7je5bldgpst4]indirectDiffuseUnoccluded Ambient Light Group
· [bookmark: _cxf1jpps7prk]indirectSpecularUnoccluded Ambient Light Group
· [bookmark: _nj7a88artsjj]transmissive Ambient Light Group
· [bookmark: _nknjwuqwmbsq]albedo
· [bookmark: _cxf1jpps7prk1]emissive Ambient Light Group (only one per file)
· [bookmark: _yw1znpxsmrv2]directDiffuse Spot Light Group
· [bookmark: _raetfjtv3952]directSpecular Spot Light Group
· [bookmark: _twlrk9c4gkd5]indirectDiffuseUnoccluded Spot Light Group
· [bookmark: _cxf1jpps7prk2]indirectSpecularUnoccluded Spot Light Group
· [bookmark: _jf4yf5axrcga]transmissive Ambient Light Group

· [bookmark: _gqaauo2lrf0e]Char Render Layer (extra unique light group, no transmissive or emissive since this character has no glass or visible light materials, character Camera Visibility turned on, environment Camera Visibility turned off)
· [bookmark: _h7aogppkkinf]directDiffuse Ambient Light Group
· [bookmark: _4y0y8datwv19]directSpecular Ambient Light Group
· [bookmark: _qkr0s7b79nie]indirectDiffuseUnoccluded Ambient Light Group
· [bookmark: _qe4kil7zmq3q]indirectSpecularUnoccluded Ambient Light Group
· [bookmark: _3xo12nv1xsd]directDiffuse Spot Light Group
· [bookmark: _fikmte4citk7]directSpecular Spot Light Group
· [bookmark: _wu5tmk5zf7j6]indirectDiffuseUnoccluded Spot Light Group
· [bookmark: _miby67blua5a]indirectSpecularUnoccluded Spot Light Group
· [bookmark: _nqd0fy1eyh39]directDiffuseUnoccluded Key Light Group
· [bookmark: _rvhj7a5jy92q]directDiffuse Key Light Group
· [bookmark: _1akl9idgu9s4]directSpecular Key Light Group
· [bookmark: _nz7gmawqc8tx]indirectDiffuseUnoccluded Key Light Group
· [bookmark: _bzissspmyv4y]indirectSpecularUnoccluded Key Light Group
· [bookmark: _gkstn5xqesd]albedo
· [bookmark: _r7lniihquoc5]Data Render Layer (rendered using the AO integrator)
· [bookmark: _r7lniihquoc51]rgba (the beauty pass for AO)
· [bookmark: _r7lniihquoc52]MatteID0
· [bookmark: _r7lniihquoc53]MatteID1
· [bookmark: _r7lniihquoc54]MatteID2
· [bookmark: _r7lniihquoc55]MatteID3
· [bookmark: _r7lniihquoc56]motionFore
· [bookmark: _i3dx6cf5lk0b]Z
Each of these Maya scene files will then be batch rendered to get all the necessary passes for composite.
[bookmark: _t00szzkds0q0] Batch Rendering with Command Line
[bookmark: _av3bh0qks2e5]Basic
[bookmark: _yhe0d82143z]C:\Program Files\Autodesk\Maya2017\bin>.\render -r rman -proj project_folder_location ma_file_location
[bookmark: _21450xrxeewz]C:\Program Files\Pixar\RenderManProServer-21.4\bin>prman.exe -cwd C:\Users\ry101290\Desktop\nl_rendering\ -Progress C:\Users\ry101290\Desktop\nl_rendering\renderman\shot69_v3\rib\0304\shotshape69_Final.0304.rib
To quickly access the command line on windows, press the windows key [image: ], then type “cmd” and press enter. Here is a preview of the what it should look like:
[image: ]
To change your working directory to the one where the maya render.exe is located type the following and press enter:
[bookmark: _14r4vqf21us3]cd C:\program files\autodesk\maya2017\bin
The “cd” command changes the directory you are working from.
Once you have the following in the command line, you are ready to enter the render command:
[bookmark: _5h7kfdmzd4oi]C:\Program Files\Autodesk\Maya2017\bin>
Type the following, replacing “ma_file_location” with the specific location and filename for the .ma file you want to render (i.e. C:\Users\username\Desktop\02_PreProduction_Production_Maya\scenes\test.ma , don’t use spaces in any of your folder or file names):
[bookmark: _o497onftfrt0].\render -r rman -proj project_folder_location ma_file_location
The “.\” runs the program using the full path. “render” is the name of the maya batch renderer, everything after this is considered an argument for the renderer program as it runs. “-r” tells it which renderer to use. “rman” is the shorthand name for Renderman. The “-proj” tells the renderer the specific location of the project folder. If you do not include the project folder location, the renderer may render out to the default Maya project folder.The last argument will always be the file you want to render including its full path.
Running the batch renderer in this way will save out rendered images to the renderman folder inside the specified project folder. Following is an example file path for the rendered images:
[bookmark: _55v0o376gfoc]C:\Users\username\Desktop\02_PreProduction_Production_Maya\renderman\test\images
[bookmark: _wdrh8h25z16g]With MEL Injection for Channel/Output Creation
[bookmark: _cznkx91wy69c]C:\Program Files\Autodesk\Maya2017\bin>.\render -r rman -preRender "rmanAddOutput rmanFinalGlobals directDiffuse; rmanAddOutput rmanFinalGlobals directDiffuseUnoccluded;" -proj project_folder_loaction ma_file_location
The new argument “-preRender” injects a MEL script into the render process, this particular injection happens before the renderer starts rendering. Your MEL script must be enclosed between quotation marks.
[bookmark: _lj50q18a85iw]rmanAddOutput rmanFinalGlobals directDiffuse;
[bookmark: _qixzb724xmx7]rmanAddOutput rmanFinalGlobals directDiffuseUnoccluded;
“rmanAddOutput” is a Renderman specific MEL command that adds an output and channels to your render. “rmanFinalGlobals” is the name of the default final render pass that Renderman uses, you will be adding your outputs/channels to this pass for rendering. “directDiffuse” and “directDiffuseUnoccluded” are two example channels you will be using.
[bookmark: _nktl3xr2ovnk]Renderman Channels
The following are all the default channels available in Renderman, not including custom written ones:
[bookmark: _m06m4e5rri6v]Ci
[bookmark: _p20klgyr703e]MatteID0 MatteID1 MatteID2 MatteID3 MatteID4 MatteID5 MatteID6 MatteID7
[bookmark: _xde2ksjm9lqc]Ngn Nn Non Oi P PRadius Po Tn VLen Vn __Nref __Nworld __Pref __Pworld __WNref __WPref __depth __st a
[bookmark: _jwljv1du9ecp]albedo beauty cpuTime curvature dPdtime dPdu dPdv dPdw
[bookmark: _pw84vvyh77qg]denoise_Ci denoise_a denoise_albedo denoise_albedo_var denoise_backward denoise_diffuse denoise_diffuse_mse denoise_forward denoise_mse denoise_normal denoise_normal_var denoise_specular denoise_specular_mse denoise_z denoise_z_var
[bookmark: _cwjqc1yhc2d7]directDiffuse directDiffuseLobe directDiffuseUnoccluded directSpecular directSpecularClearcoatLobe directSpecularFuzzLobe directSpecularGlassLobe directSpecularIridescenceLobe directSpecularPrimaryLobe directSpecularRoughLobe directSpecularUnoccluded du dv dw emissive id incidentRayRadius incidentRaySpread indirectDiffuse indirectDiffuseLobe indirectDiffuseUnoccluded indirectSpecular indirectSpecularClearcoatLobe indirectSpecularFuzzLobe indirectSpecularGlassLobe indirectSpecularIridescenceLobe indirectSpecularPrimaryLobe indirectSpecularRoughLobe indirectSpecularUnoccluded motionBack motionFore mpSize occluded outsideIOR sampleCount shadow subsurface subsurfaceLobe time transmissive transmissiveGlassLobe transmissiveSingleScatterLobe u unoccluded v w z
You can get a list of these channels by typing “rmanGetChannelClasses;” into the script editor and running it. You will only be using a small number of these to composite in Nuke.
The ones you will most likely use are (not including data channels):
[bookmark: _djxpvcc8xufy]directDiffuse
[bookmark: _djxpvcc8xufy1]directDiffuseUnoccluded
[bookmark: _djxpvcc8xufy2]directSpecular
[bookmark: _djxpvcc8xufy3]indirectDiffuseUnoccluded
[bookmark: _djxpvcc8xufy4]indirectSpecularUnoccluded
[bookmark: _djxpvcc8xufy5]transmissive
[bookmark: _djxpvcc8xufy6]emissive
You will also be rendering out an Ambient Occlusion pass that will be mixed into the indirect channels.
[bookmark: _ryxgocr1t1h9]Using a .BAT File
A way to run consecutive renders without having to manually initiate each file is to use some automation using a .BAT file (Windows Batch file). The .BAT will use scripting to render one scene file after the other. Here is an example version that runs two files:
[bookmark: _c3fmcvvyu5vh]rem Change the next 3 lines to suit your project.
[bookmark: _c3fmcvvyu5vh1]rem If you render from the desktop, people can simply drag and drop the
[bookmark: _c3fmcvvyu5vh2]rem project folder and run from there.
[bookmark: _c3fmcvvyu5vh3][bookmark: _c3fmcvvyu5vh3]
[bookmark: _c3fmcvvyu5vh4]SET DESK=%userprofile%\desktop
[bookmark: _c3fmcvvyu5vh5][bookmark: _c3fmcvvyu5vh5]
[bookmark: _c3fmcvvyu5vh6]rem The actual name of the project folder.
[bookmark: _c3fmcvvyu5vh7]SET PROJ=%DESK%\RENDERING
[bookmark: _c3fmcvvyu5vh8][bookmark: _c3fmcvvyu5vh8]
[bookmark: _c3fmcvvyu5vh9]rem The folder you want render out to. This is the default.
[bookmark: _c3fmcvvyu5vh10]SET RD=%PROJ%\renders
[bookmark: _c3fmcvvyu5vh11][bookmark: _c3fmcvvyu5vh11]
[bookmark: _c3fmcvvyu5vh12]rem Default scenes folder
[bookmark: _c3fmcvvyu5vh13]SET SCNPATH=%PROJ%\scenes
[bookmark: _c3fmcvvyu5vh14][bookmark: _c3fmcvvyu5vh14]
[bookmark: _c3fmcvvyu5vh15]rem Name of scene file
[bookmark: _c3fmcvvyu5vh16]SET SCN=shot61_environment
[bookmark: _c3fmcvvyu5vh17][bookmark: _c3fmcvvyu5vh17]
[bookmark: _c3fmcvvyu5vh18]rem Starting frame
[bookmark: _c3fmcvvyu5vh19]SET FS=100
[bookmark: _c3fmcvvyu5vh20][bookmark: _c3fmcvvyu5vh20]
[bookmark: _c3fmcvvyu5vh21]rem Ending frame
[bookmark: _c3fmcvvyu5vh22]SET FE=430
[bookmark: _c3fmcvvyu5vh23][bookmark: _c3fmcvvyu5vh23]
[bookmark: _c3fmcvvyu5vh24]rem Default install location for Maya
[bookmark: _c3fmcvvyu5vh25]CD C:\Program Files\Autodesk\Maya2017\bin
[bookmark: _c3fmcvvyu5vh26][bookmark: _c3fmcvvyu5vh26]
[bookmark: _c3fmcvvyu5vh27].\render -r rman -s %FS% -e %FE% -proj "%PROJ%" -rd "%RD%" "%SCNPATH%\%SCN%.mb"
[bookmark: _c3fmcvvyu5vh28][bookmark: _c3fmcvvyu5vh28]
[bookmark: _c3fmcvvyu5vh29]rem Changing the scene and then rendering it. Will run once the first scene is done.
[bookmark: _c3fmcvvyu5vh30]SET SCN=shot61_characters
[bookmark: _z1cyx9gugkni].\render -r rman -s %FS% -e %FE% -proj "%PROJ%" -rd "%RD%" "%SCNPATH%\%SCN%.mb"
If you save this as a plain text .BAT file, then run that file, it will start the rendering process inside a command line window automatically.
[bookmark: _tgayqi32pkdf]Important References
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